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ทำความรู้จักกับ e-book 

หนังสืออิเล็กทรอนิกส์ หรือท่ีรู้จักกันในชื่ออีบุ๊ค (eBook หรือ e-Book) เป็นคำภาษาต่างประเทศ 

ย่อมาจากคำว่า electronic book หมายถึง หนังสือที่สร้างขึ้นด้วยโปรแกรมคอมพิวเตอร์มีลักษณะเป็น

เอกสารอิเล็กทรอนิกส์ โดยปกติมักจะเป็นแฟ้มข้อมูลคอมพิวเตอร์ที่สามารถอ่านเอกสารผ่านทางหน้า

จอคอมพิวเตอร์ทั้งในระบบออฟไลน์และออนไลน์  คุณลักษณะของหนังสืออิเล็กทรอนิกส์สามารถเชื่อมโยง

จุดไปยังส่วนต่างๆ ของหนังสือ เว็บไซต์ต่างๆ ตลอดจนมีปฏิสัมพันธ์และโต้ตอบกับอ่ืนได้ นอกจากนั้น

หนังสืออิเล็กทรอนิกส์สามารถแทรกภาพ เสียง ภาพเคลื่อนไหว แบบทดสอบ และสามารถสั่งพิมพ์เอกสาร

ที่ต้องการออกทางเครื่องพิมพ์ได้ อีกประการหนึ่งที่สำคัญก็คือ หนังสืออิเล็กทรอนิกส์สามารถปรับปรุง

ข้อมูลให้ทันสมัยได้ตลอดเวลา ซึ่งคุณสมบัติเหล่านี้จะไม่มีในหนังสือธรรมดาทั่วไป 

1. ลักษณะของ e-Book

รูปแบบสิ่งพิมพ์ด้านอิเล็กทรอนิกส์และมัลติมีเดีย โดยเฉพาะอย่างยิ่งผลิตภัณฑ์ที่เป็นแผ่นจาน

ข้อมูลเสียง เช่น ซีดีรอม แผ่นซีดีรอมสามารถจัดข้อมูลได้จำนวนมากในรูปแบบของตัวอักษรทั้งลักษณะ

ภาพดิจิตอล ภาพอะนิเมชั่น วีดีโอ ภาพเคลื่อนไหวต่อเนื่อง คำพูด เสียงดนตรี และเสียงอ่ืน ๆ 

- รูปแบบหนังสือที่อยู่ในรูปแบบดิจิทัล โดยแสดงให้เห็นบนจอคอมพิวเตอร์ไม่บังคับการพิมพ์และ

การเข้าเล่ม

- รูปแบบของหนังสือที่สามารถนำข้อมูลต่าง ๆ ลงไปจัดเก็บลงในเครื่อง Smart Phone หรือ

Tablet ทำให้สามารถที่จะพกพาหนังสือหรือเอกสารจำนวนมากไปอ่าน ณ ที่ใดก็ได้ เพียงแต่นำ

เครื่อง Smart Phone หรือ Tablet  ติดตัวไปเพียงเครื่องเดียว

2. องค์ประกอบของ E-book

1. เครื่องอ่าน หรือคอมพิวเตอร์ Notebook/อุปกรณ์ Smart Phone/อุปกรณ์ Tablet

2. ซอฟต์แวร์ (ซอฟต์แวร์สำหรับการอ่าน และ ซอฟต์แวร์สำหรับการเขียน)

3. มาตรฐานของตัวหนังสือ

4. Security / Protection Tools & Standard

5. Multi Function Devices

6. อักขระ (Text) หรือข้อความ

7. ภาพนิ่ง (Still Image)

8. ภาพเคลื่อนไหว (Animation)
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9. เสียง (Sound)

10. ภาพวีดิทัศน์ (Video)

11. การจัดเก็บข้อมูลมัลติมีเดีย

3. ประเภทของหนังสืออิเล็กทรอนิกส์

หนังสืออิเล็กทรอนิกส์ แบ่งออกเป็น 10 ประเภท 

1) หนังสืออิเล็กทรอนิกส์ หรือแบบตำรา (Textbooks)

2) หนังสืออีเล็กทรอนิกส์ แบบหนังสือเสียงอ่าน มีเสียงคำอ่าน

3) หนังสืออิเล็กทรอนิกส์แบบหนังสือภาพนิ่ง หรืออัลบั้มภาพ (static Picture Books)

4) หนังสืออิเล็กทรอนิกส์ แบบหนังสือภาพเคลื่อนไหว (Moving Picture Books)

5) หนังสืออิเล็กทรอนิกส์แบบหนังสือสื่อประสม (Multimedia)

6) หนังสืออิเล็กทรอนิกส์แบบหนังสือสื่อหลากหลาย (Polymedia books)

7) หนังสืออิเล็กทรอนิกส์แบบหนังสือเชื่อมโยง ( Hypermedia Book)

8) หนังสืออิเล็กทรอนิกส์แบบหนังสืออัจฉริยะ ( Intelligent Electronic Books)

9) หนังสืออิเล็กทรอนิกส์ แบบสื่อหนังสือทางไกล ( Telemedia Electronic Books)

10) หนังสืออิเล็กทรอนิกส์แบบหนังสือไซเบอร์เสปซ (Cyberspace books)

4. โครงสร้างหนังสืออิเล็กทรอนิกส์ (e-book )

โครงสร้างของหนังสืออิเล็กทรอนิกส์ประกอบด้วย 
1. หน้าปก (Front Cover) หมายถึง ปกด้านหน้าของหนังสือซึ่งจะอยู่ส่วนแรก เป็นตัวบ่งบอกว่า

หนังสือเล่มนี้ชื่ออะไร ใครเป็นผู้แต่ง

2. คำนำ (Introduction) หมายถึง คำบอกกล่าวของผู้เขียนเพ่ือสร้างความรู้ ความเข้าใจเกี่ยวกับ

ข้อมูล และเรื่องราวต่างๆ คำนำ ของหนังสือเล่มนั้น

3. สารบัญ (Contents) หมายถึง ตัวบ่งบอกหัวเรื่องสำคัญที่อยู่ภายในเล่มว่าประกอบด้วย

อะไรบ้าง อยู่ที่หน้าใดของหนังสือ สามารถเชื่อมโยงไปสู่หน้าต่าง ต่างๆ ภายในเล่มได้

4. สาระของหนังสือแต่ละหน้า (Pages Contents) หมายถึง ส่วนประกอบสำคัญในแต่ละหน้า ที่

ปรากฏภายในเล่ม  ประกอบด้วย

• หน้าหนังสือ (Page Number)

• ข้อความ (Texts)
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• ภาพประกอบ (Graphics) .jpg, .gif, .bmp, .png, .tiff

• เสียง (sounds) .mp3, .wav, .midi

• ภาพเคลื่อนไหว (video Clips, flash) .mpeg, .wav, .avi

• จุดเชื่อมโยง (Links)

5. อ้างอิง (Reference) หมายถึง แหล่งข้อมูลที่ใช้นำมาอ้างอิง อาจเป็นเอกสาร ตำรา หรือ

เว็บไซต์ก็ได้

6. ดัชนี (Index) หมายถึง การระบุคำสำคัญหรือคำหลักต่างๆ ที่อยู่ภายในเล่ม โดยเรียงลำดับ

ตัวอักษรให้สะดวกต่อการค้นหาพร้อมระบุเลขหน้าและจุดเชื่อมโยง

7. ปกหลัง (Back Cover) หมายถึง ปกด้านหลังของหนังสือซึ่งจะอยู่ส่วนท้ายเล่ม
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แนะนำโปรแกรม e-book 
FlipAlbum Vista Pro (โปรแกรมทำอัลบัมภาพ โฟโต้บุ๊ค อีบุ๊ค e-book)
โปรแกรมทำอัลบัมภาพ โฟโต้บุ๊ค อีบุ๊ค โดยสามารถทำได้ทั้งภาพน่ิงและวิดีโอเคลื่อนไหว เป็น

โปรแกรมที่จะช่วยให้คุณสามารถออกแบบและมีหนังสืออิเล็กทรอนิกส์ได้อย่างง่ายดาย สามารถกำหนด
ความสามารถในการปกป้องผลงานของคุณในแผ่นซีดี และคุณยังสามารถที่จะเข้ารหัสรูปถ่ายของคุณตั้ง
รหัสผ่าน และวันหมดอายุปิดการใช้งานการพิมพ์และการเพิ่มลายน้ำให้กับรูปถ่ายในอัลบั้มของคุณ พร้อม
ทั้งสามารถนำออกแสดง แจกจ่าย หรือขายได้ตามต้องการ  

แนะนำโปรแกรม e-Book : FlipAlbum Vista Pro 
1. More Product Features (คุณสมบัติของผลิตภัณฑ์)

❑ Intuitive Viewing Experience (ประสบการณ์รับชมที่ใช้งานง่าย)

• การพลิกหน้าแบบสมจริง ระบบ 3D ให้คุณมีประสบการณ์ในการชมธรรมชาติและใช้งาน
ง่าย

• ด้วย Multi-page สามารถให้คุณเรียกดูอัลบัมของคุณได้อย่างรวดเร็ว

• สามารถ preview ภาพตัวอย่างได้อย่างง่ายๆ ในโหมดเต็มจอ

• สามารถเปรียบเทียบเน้ือหาของอัลบัมที่แตกต่างกันได้
❑ Easy to Create, Manage and Organize (ง่ายต่อการสร้าง จัดการและจัดระเบียบ)

• คุณสามารถที่อัลบัมภาพของคุณได้อย่างง่ายดาย และ รวดเร็ว เพียงแค่ 3 ขั้นตอน

• มีแม่แบบเค้าโครงที่จะสามารถช่วยให้คุณเลือกรูปแบบที่แตกต่างกัน ได้อย่างหลากหลาย

• สามารถสร้างรูปแบบเต็มหน้ากับภาพถ่ายหลายภาพ, ข้อความเสียงและมัลติมีเดีย เล่น
ไฟล์มัลติมีเดียโดยตรงบนหน้าอัลบั้ม

• เพิ่มบุ๊คมาร์ค ปรับแต่งรูปทรงและสีของบุ๊คมาร์ค

• ฟังก์ชั่นการค้นหา ค้นหาสตริงข้อความและคำอธิบายประกอบในหน้าอัลบั้ม
❑ Customize with Editing Controls (ปรับแต่งด้วยการควบคุม การแก้ไข)

• สร้างรูปแบบของคุณเองสำหรับโอกาสใด ๆ กับรูปแบบที่คุณชื่นชอบ ทั้งปกหลังหนังสือ
และพื้นหลังของหน้า

• สามารถใส่เพลง mp3 ที่คุณชื่นชอบเป็นหน้าเว็บหรือเพลงพื้นหลังได้

• สามารถเพิ่มแสงและเงาได้

• สามารถเลือกวัตถุหลายๆอย่าง และคุณสามารถตัด, คัดลอก, ย้าย, ลบ, หมุน, ปรับ
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ขนาด, เพิ่มผลต้ัง การเชื่อมโยงและอื่นๆ ในการเลือกของคุณทั้งหมดในคร้ังเดียว 

• สามารถใส่ข้อความบันทึกย่อแบบโปร่งแสงได้

❑ Encryption and Security (การเข้ารหัสและความปลอดภัย)

• สามารถเข้ารหัสเพื่อป้องกันเน้ือหาที่มีลิขสิทธิ์ของคุณเพื่อป้องกันการคัดลอกโดยไม่ได้รับ
อนุญาติจากซีดีของคุณ

• การกำหนดรหัสผ่านของซีดี อัลบั้มรูปของคุณเพื่อป้องกันการเข้าถึงไม่ได้รับอนุญาต

• เพิ่มลายน้ำข้อความเช่นชื่อหรือลิขสิทธิ์ของคุณลงบนภาพของคุณ

❑ Export and Share (ส่งออกและแบ่งปัน)

• อัพโหลดและแบ่งปันอัลบั้มภาพถ่ายของคุณบนอินเทอร์เน็ตกับเพื่อนและครอบครัว

• เล่นบนเคร่ืองเล่นดีวีดีที่รองรับแผ่น CD-R / RW, DVD ±สื่อ R / RW, สำหรับการดูทีวี

• สามารถส่งออกอัลบั้มภาพไปยังรูปแบบ MPEG-2 สำหรับการสร้าง SVCD หรือ DVD

• พิมพ์อัลบั้มภาพทั้งหมดหรือเพจที่เลือก พิมพ์ภาพถ่ายหลายภาพบนกระดาษแผ่นเดียว
ภาพ

❑ Presentation (การนำเสนอ)

• ฟังก์ชั่น ออโต้พลิกที่ทำให้สามารถกำหนดทิศทางการพลิกที่จะเริ่มต้นอย่างใดอย่างหน่ึง
จากซ้ายไปขวาหรือในทางกลับกัน

• แสดงสไลด์อัตโนมัติ นำเสนอเน้ือหาของหนังสือของคุณเป็นสไลด์โชว์ที่มีการเล่น
อัตโนมัติ สไลด์ตัวเลือกการแสดงรวมถึงช่วงเวลาที่ตัวแปร ระหว่างภาพน่ิงผลการ
เปลี่ยนแปลงจำนวนแถวและคอลัมน์ของภาพ

2. ประโยชน์ของ e-book

สำหรับผู้อ่าน 

1. ขั้นตอนง่ายในการอ่าน และค้นหาหนังสือ

2. ไม่เปลืองเน้ือที่ในการเก็บหนังสือ

3. อ่านหนังสือได้จากทุกที่ที่มีการเชื่อมต่ออินเตอร์เน็ต

สำหรับห้องสมุด 

1. สะดวกในการให้บริการหนังสือ

2. ไม่ต้องใช้สถานที่มากในการจัดเก็บหนังสือ และไม่เสียค่าใช้จ่ายในส่วนน้ี

3. ลดงานที่เกิดจากการซ่อม จัดเก็บ และการจัดเรียงหนังสือ
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4. ไม่เสียค่าใช้จ่ายในการจ้างพนักงานมาดูแลและซ่อมแซมหนังสือ

5. มีรายงานแสดงการเข้ามาอ่านหนังสือ

สำหรับสำนักพิมพ์และผู้เขียน 

1. ลดขั้นตอนในการจัดทำหนังสือ

2. ลดค่าใช้จ่ายและความเลี่ยงในการจัดพิมพ์หนังสือ

3. ลดค่าใช้จ่ายในการจัดจำหน่ายผ่านช่องทางอื่นๆ

4. เพิ่มช่องทางในการจำหน่ายหนังสือ

5. เพิ่มช่องทางในการประชาสัมพันธ์ตรงถึงผู้อ่าน

3. ข้อดีของ e-book /ข้อเสีย E-book

1. อ่านที่ไหน เมื่อไหร่ได้ตลอดเวลา เน่ืองจากพกไปได้ตลอด และได้จำนวนมาก
2. ประหยัดการตัดไม้ทำลายป่า เพราะไม่ต้องตัดไม้มาทำกระดาษ
3. เก็บรักษาได้ง่าย ประหยัดเน้ือที่ในการจัดเก็บ ประหยัดค่าเก็บรักษา
4. ค้นหาข้อความได้ ยกเว้นว่าอยู่ในลักษณะของภาพ
5. ใช้พื้นที่น้อยในการจัดเก็บ
6. อ่านได้ในที่มืด หรือแสงน้อย
7. ทำสำเนาได้ง่าย
8. จำหน่ายได้ในราคาถูกกว่าในรูปแบบหนังสือ
9. อ่านได้ไม่จำกัดจำนวนคร้ัง เพราะไม่ยับหรือเสียหายเหมือนกระดาษ
10. สะดวกสบาย ไม่ต้องเดินทาง แค่คลิกเดียวก็สามารถเลือกอ่านหนังสือที่ต้องการได้ทันที
11. ประหยัดต้นทุนในการดำเนินการ
12. สามารถอยู่ทนทานได้เป็นระยะเวลานาน
13. ไม่ต้องสต็อคของไว้เป็นจำนวนมากๆ
14. คุณลักษณะพิเศษกว่าหนังสือกระดาษหลายประการ อาทิ แสดงผลด้วย ภาพ ข้อความ เสียง

ภาพเคลื่อนไหว เป็นต้น
15. ยังสามารถเชื่อมโยงกับข้อความต่างๆ ภายในตัวหนังสือหรือภายนอกเว็บไซต์อื่นๆ จาก

อินเทอร์เน็ต
16. ผู้อ่านสามารถอ่านพร้อมๆ กันได้โดยไม่ต้องรอการยืมหรือคืนเหมือนหนังสือกระดาษในห้องสมุด
17. รูปแบบหนังสือที่อยู่ในรูปแบบดิจิทัล โดยแสดงให้เห็นบนจอคอมพิวเตอร์ไม่บังคับการพิมพ์และ

การเข้าเล่ม
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18. สามารถ เรียนรู้ เข้าถึงองค์ความรู้ได้สะดวก ทั้งเวลา สถานที่
4. ข้อดีของ e-book /ข้อเสีย E-book

❑ ต้องอาศัยพลังงานในการอ่านตลอดเวลา ไม่ว่าจะเป็นไฟฟ้าหรือแบตเตอร่ี

❑ เสียสุขภาพสายตา จากการได้รับแสงจากอุปกรณ์อิเล็กทรอนิกส์

❑ ขาดความรู้สึก หรืออรรถรส หรือความคลาสสิก

❑ อาจเกิดปัญหากับการลง Hardware หรือ Software ใหม่หรือแทนที่อันเก่า

❑ ต้องมีการดูแลไฟล์ให้ดี ไม่ให้เสียหรือสูญหาย

❑ การอ่านอาจเกิดอันตรายต่อสายตา

❑ เกิดการละเมิดลิขสิทธิ์ได้ง่าย

❑ ไม่เหมาะกับการ format เช่น รูปว่าด รูปถ่าย แผนที่ใหญ่ เป็นต้น

❑ การอ่านที่ยุ่งยากต้องอ่านจากคอมพิวเตอร์ /Notebook หรือ Smart Phone/Tablet

❑ ต้องอาศัยระบบเครือข่าย
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ข้ันตอนการดาวน์โหลด การติดตั้งโปรแกรม 
1. เปิด Browser ป้อน

http://www.mediafire.com/file/l2zulr0fbja74sb/FlipAlbum_Vista_Pro_7.0.1.363.Ret
ail.rar/file กด enter 
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2. คลิกปุ่ม จะปรากฏหน้าจอดังรูป 

3. คลิก Flip Album Vista Pro….rar โปรแกรมจะแสดงกล่องข้อความดังรูป 
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คู่มือการใช้งาน 

4. ดับเบิ้ลคลิก โฟเดอร์ Flip Album Vista Pro 7.0.1.363.Retail จะปรากฏหน้าจอดังรูป

5. ดับเบิ้ลคลิก fo-fap7.exe จะปรากฏหน้าจอดังรูป

Do you want to allow this app to make changes to your device? 
คุณต้องการอนุญาตให้แอปน้ีทำการเปลี่ยนแปลงอุปกรณ์ของคุณหรือไม่ 

- คลิกปุ่ม yes
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คู่มือการใช้งาน 

6. คลิกปุ่ม

- คลิก  I accept the terms in the license agreement 

- คลิกปุ่ม
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คู่มือการใช้งาน 

- ป้อน User Name

- คลิก  เพื่อเลือก Anyone who uses this computer (all Users) (ใครก็ตามที่ใช้
คอมพิวเตอร์เคร่ืองน้ี (ผู้ใช้ทั้งหมด) หรือ Only for me (Training) (สำหรับฉันเท่าน้ัน 
(การฝึกอบรม) 

7. คลิกปุ่ม
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คู่มือการใช้งาน 

- โปรแกรมที่ ติดต้ัง จะอยู่ที่ drive หรือ คลิกปุ่ม  เพื่อเปลี่ยนที่ติดต้ัง
โปรแกรม

8. คลิกปุ่ม  Next 

9. คลิกปุ่ม Install
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10. คลิกปุ่ม

11. คลิกปุ่ม Start Manu เลือกไอคอล Flip Album Pro หรือดับเบิ้ลคลิกที่ไอคอล  หน้า
Desktop จะปรากฏหน้าจอดังรูป

- ป้อน Activation Key จากโฟเดอร์ Flip Album Vista Pro 7.0.1.363.Retail
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- ดับเบิ้ลคลิก Serial.txt จะปรากฏกล่องข้อความ Notepad ดังรูป

- นำอักษรในกรอบสีแดงไปใส่ในช่อง Activation Key ดังรูป

- คลิกปุ่ม
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- คลิกปุ่ม  จะปรากฏหน้าจอดังรูป 

หน้าจอ Flip Album Vista Pro
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การเรียนรู้การใช้งานโปรแกรม Flip Album 

ส่วนประกอบของโปรแกรม Flip Album Vista Pro 

เมื่อเปิดโปรแกรม Flip Album Vista Pro ขึ้นมาจะปรากฏหน้าจอดังรูป 

จากหน้าจอโปรแกรม Flip Album Vista Pro จะประกอบไปด้วยส่วนต่างๆ ดังนี้ 
1. แถบรายการคำสั่ง หรือแถบเมนู (Menu Bar) คือส่วนที่รวบรวมคำสั่งทั้งหมดที่เรียกใช้ใน

โปรแกรม Flip Album Vista Pro เพ่ือสั่งการให้โปรแกรมทำงานตามที่ต้องการ ซ่ึงจะมีเมนูย่อย จำนวน 
12 กลุ่ม ดังรูป 

1. เมนู File ประกอบด้วยเมนูย่อย ดังต่อไปนี้
1.1. New Book สร้างหนังสือใหม่
1.2. Open Book เปิดหนังสือที่เคยสร้างไว้
1.3. Start Wizard ใช้เครื่องมือช่วยในการสร้างหนังสือ
1.4. Save บันทึกหนังสือที่กำลังเปิดอยู่
1.5. Save As… บันทึกหนังสือท่ีกำลังเปิดเป็นชื่ออ่ืน เป็นการทำสำเนาหนังสือที่กำลังเปิดอยู่ขึ้น

อีก 1 ชุด หรือใช้ในการบันทึกหนังสือที่สร้างขึ้นครั้งแรกและไม่เคยบันทึกมาก่อน 
1.6. Upload to Web… เพ่ือนำหนังสือขึ้นเผยแพร่บนเว็ปไซส์ 
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คู่มือการใช้งาน  

1.7. Send a Email… เพ่ืออัพโหลดไฟล์ในรูป OPF ไปทาง e-Mail จะทำได้กับOnline 
Facebook เท่านั้น 

1.8. Add Book to www.flipbrary.com...  คือการUpload book ที่สร้างไปลงทะเบียนที่ไว้
ไปที่เว็ปไซส์ www.fliplibrary.com 

1.9. Online Update เพ่ืออัพเดทโปรแกรมFlip Album Vista Pro ใหม่ 
1.10. Print เพ่ือพิมพ์หนังสือที่เลือก 
1.11. Exit เพ่ือออกจากโปรแกรม 

2. เมนู Folder ประกอบด้วยเมนูย่อย ดังต่อไปนี้
2.1. New Folder เพ่ือสร้างโฟลเดอร์ที่เก็บงานใหม่
2.2. Open Folder เพ่ือเปิดงานในโฟลเดอร์เก่าที่สร้างไว้
2.3. Delete Folder เพ่ือลบงานในโฟลเดอร์ที่สร้างไว้
2.4. Copy From… เพ่ือคัดลอกข้อมูลมาจากท่ีอ่ืน
2.5. Save as เพ่ือบันทึกหนังสือเป็น...
2.6. Move To เพ่ือย้ายข้อมูลไปที่อ่ืน
2.7. Rename เพ่ือเปลี่ยนชื่อแฟ้มข้อมูล
2.8. Delete เพ่ือลบข้อมูล

3. เมนู Edit ประกอบด้วยเมนูย่อย ดังต่อไปนี้

3.1. Select Objects เพ่ือเลือกวัตถุท่ีต้องการซึ่งอยู่บนหน้าหนังสือ ถ้าคลิกเครื่องหมาย
ไว้เมื่อเคลื่อนเมาส์ไปบนวัตถุ เช่นรูปภาพ ตัวชี้เมาส์ก็จะเปลี่ยนเป็นรูปมือ และเมื่อคลิก
เมาส์บนวัตถุจะเป็นการเลือกวัตถุนั้นโดยจะมีเส้นล้อมรอบ และมีจุดสี่เหลี่ยมที่มุมของวัตถุ 

3.2. Undo เพ่ือยกเลิกการทำงานของคำสั่งสุดท้าย 
3.3. Redo เพ่ือกลับเอาคำสั่งสุดท้ายที่ยกเลิกมาทำงาน 
3.4. Cut เพ่ือตัดหน้าเอกสารบุ๊คPage หรือวัตถุที่เลือกไว้ โดยจะเป็นคำสั่งคูก่ับPaste 
3.5. Copy เพ่ือสำเนาหน้าเอกสาร หรือวัตถุที่เลือกไว้ เป็นคำสั่งทีใ่ช้คู่กับ Paste 
3.6. Paste เพ่ือวางหน้าเอกสาร หรือวัตถุที่เลือกไว้จากการ Cut หรือ Copy 
3.7. Find… เพ่ือค้นหาคำ หรือวลีOPF file 
3.8. Selection เพ่ือเลือกวัตถุต่างๆ 
3.9. Image Edit เพ่ือแก้ไขรูปภาพ 
3.10. Rotate เพ่ือหมุนภาพที่อยู่ในบุ๊ค 
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3.11. Size Change เพ่ือปรับขนาดภาพในหน้าบุ๊ค 
3.12. Insert Annotation เพ่ือใส่กรอบข้อความ เพ่ือใส่ข้อความ หรือคำอธิบาย หรือหมายเหตุ

ในหน้าที่เลือก 
3.13. Insert Multimedia Object… เพ่ือใส่Multimedia บนหน้าบุ๊ค เช่นภาพ, เสียง หรือวีดีโอ 
3.14. Insert ClipArt เพ่ือใส่ ClipArt 
3.15. Insert Page เพ่ือแทรกหน้าเข้ามาในบุ๊ค 
3.16. Delete Page เพ่ือลบหน้าออกจากบุ๊ค 
3.17. Page Properties เพ่ือกำหนดคุณสมบัติต่างๆ ของหน้าที่เลือก 
3.18. Customize Contents เพ่ือปรับเปลี่ยนรูปแบบข้อความ, ขนาดตัวอักษร ในหน้า 

Contents 
3.19. Customize Index เพ่ือปรับเปลี่ยนรูปแบบข้อความ, ขนาดตัวอักษร ในหน้า Index 

4. เมนู View ประกอบด้วยเมนูย่อย ดังต่อไปนี้
4.1. Zoom เพ่ือการดูภาพแบบขยาย
4.2. Information เพ่ือแสดงข้อมูลเกี่ยวกับหน้าที่เลือก
4.3. Entire Book เพ่ือกำหนดโหมดของรูปแบบบุ๊ค
4.4. Left Page เพ่ือกำหนดโหมดสำหรับรูปแบบหน้าซ้ายมือ
4.5. Right Page เพ่ือกำหนดโหมดของรูปแบบสำหรับหน้าขวามือ
4.6. Thumbnail Size เพ่ือกำหนดขนาดของตัวอย่างหน้าแรกของบทในหน้าโอเวอร์วิว หรือ

หน้าแสดงภาพรวมทั้งหมดซึ่งอยู่ที่หน้าปกด้านใน 
4.7. Sort Page เพ่ือกำหนดการจัดเรียงหน้าหนังสือ 
4.8. File Type Filter เพ่ือแสดงไฟล์ประเภทตัวกรอง 
4.9. Show Grid เพ่ือแสดงเส้นตารางบุ๊ค เพ่ือช่วยให้วางวัตถุในตำแหน่งต่างๆ ได้ง่าย 
4.10. Show Ruler เพ่ือแสดงแถบเส้นบรรทัด 
4.11. Stop เพ่ือใช้Online Facebook จะทำให้หยุดการทำงานบนหน้าFlip Book 
4.12. Refresh เพ่ือใช้Online Facebook จะทำให้Flip Bookกลับมาทำงานอีกครั้ง 
4.13. Toolbar เพ่ือให้แสดงแถบเครื่องมือบนจอภาพ 
4.14. Window Frame เพ่ือให้แสดงกรอบของWindows หรือไม่แสดงกรอบของWindow 

5. เมนู Flip To ประกอบด้วยเมนูย่อย ดังต่อไปนี้
5.1. Overview เพ่ือเปิดไปที่หน้าภาพรวม
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5.2. Contents เพ่ือเปิดไปท่ีหน้าสารบัญ 
5.3. First Page เพ่ือเปิดไปที่หน้าแรก 
5.4. Index เพ่ือเปิดไปที่หน้าดัชนี 
5.5. Front Cover เพ่ือเปิดไปทีป่กหน้า 
5.6. Back Cover เพ่ือเปิดไปที่ปกหลัง 
5.7. Back เพ่ือไปยังหน้าที่เรียกดูล่าสุด 
5.8. Previous Page เพ่ือเปิดไปที่หน้าที่ผ่านมา 
5.9. Next Page เพ่ือเปิดไปที่หน้าถัดไป 
5.10. Left เพ่ือเปิดไปที่หน้าซ้าย 
5.11. Right เพ่ือเปิดไปที่หน้าขวา 
5.12. Page No… เพ่ือเปิดไปยังหน้าที่กำหนด โดยระบุหมายเลขหน้า 
5.13. File Name… เพ่ือกำหนดชื่อไฟล์ แล้วเปิดไปยังหน้าแรกของบทที่มี 

6. เมนู Bookmarks ประกอบด้วยเมนูย่อย ดังต่อไปนี้
6.1. Flip to Bookmarked Page เพ่ือเปิดไปยังหน้าทีไ่ด้กำหนดให้คั่นหนังสือเอาไว้
6.2. Add เพ่ือไปที่คั่นหนังสือที่หน้าที่กำหนด
6.3. Remove เพ่ือลบที่คั่นหนังสือที่หน้าที่ระบุออก
6.4. Define Bookmark Style เพ่ือเลือกรูปแบบที่คั่นหนังสือ
6.5. Auto Size เพ่ือกำหนดที่ค่ันหนังสือมีขนาดเท่ากันทั้งหมด หรือมีขนาดความยาวตาม

ตัวหนังสือที่อยู่ในที่ค่ันหนังสือ 
6.6. Clear All Bookmark เพ่ือเอาที่ค่ันหนังสือออกทุกตัว 

7. เมนู Markers ประกอบด้วยเมนูย่อย ดังต่อไปนี้
7.1. Flip to Marked Page เพ่ือเปิดไปยังหน้าที่ได้ทำเครื่องหมายคั่นเอาไว้
7.2. Add เพ่ือใส่เครื่องหมายคั่นหนังสือในหน้าที่เลือก
7.3. Remove เพ่ือลบเครื่องหมายคั่นหนังสือออกจากหน้าที่เลือก
7.4. Define Marker Style เพ่ือเลือกรูปแบบที่ค่ันหนังสือ
7.5. Clear All Markers เพ่ือลบเครื่องหมายที่คั่นหนังสือออกทุกตัว

8. เมนู Favorites ประกอบด้วยเมนูย่อย ดังต่อไปนี้
8.1. Add to Favorites เพ่ือเพ่ิมหน้าที่ระบุเข้าไปใน Favorites
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8.2. Organize Favorites เพ่ือจัดการรายการใน Favorites เช่นเปลี่ยนชื่อ ลบรายการที่มีอยู่ 
8.3. www.fliplibrary.com เพ่ือแสดง Home หรือ search page ที่ได้กำหนดไว้ของ 

website www.fliplibrary.com เพ่ือให้เป็น Flip Book 

9. เมนู Tools ประกอบด้วยเมนูย่อย ดังต่อไปนี้
9.1. Flipping Control เพ่ือควบคุมการพลิกหน้าหนังสือ
9.2. Auto Flip เพ่ือพลิกหน้าหนังสือโดยอัตโนมัติ
9.3. Slide Show เพ่ือเรียกดู OPF file ในรูปแบบ slide show คือเปิดแสดงทีละหน้า
9.4. Create Theme เพ่ือการสร้างรูปแบบสำเร็จรูปใหม่

10. เมนู CD Maker ประกอบด้วยเมนูย่อย ดังต่อไปนี้
10.1. Create Album CD เพ่ือสร้างไฟล์นำเสนอเป็นซีดี
10.2. Export Album for TV Viewing เพ่ือนำส่งไฟล์ออกนำเสนอบนทีวี
หมายเหตุ เมนู CD Marker จะไม่ทำงาน ถ้าเปิดแฟ้มข้อมูลในรูปแบบ .opd

11. เมนู Options ประกอบด้วยเมนูย่อย ดังต่อไปนี้
10.1. Book Binder เพ่ือกำหนดให้หนังสือมีสันห่วง
10.2. Enable Background Music เพ่ือกำหนดให้เลือกเสียงเพลงเป็นBackground หรือไม่
10.3. Set Flipping Speed เพ่ือกำหนดความเร็วในการเปิดหน้าหนังสือ
10.4. Set Auto Flipping… เพ่ือกำหนดค่าต่างๆ สำหรับการพลิกหน้าหนังสือแบบอัตโนมัติ
10.5. Set Slide Show… เพ่ือกำหนดค่าต่างๆ สำหรับการพลิกหน้าหนังสือแบบสไลด์โชว์
10.6. Set Theme เพ่ือกำหนดรูปแบบ Theme สำหรับFlip Book
10.7. Set Book Option เพ่ือกำหนดรูปแบบFlip Bookในครั้งเดียว
10.8. Set Preferences เพ่ือกำหนดค่า Preferences ให้กับFlip Book
10.9. Refresh Thumbnails เพ่ือลบภาพ Thumbnails ที่มีอยู่ในหน้า Overviewออก

ทั้งหมด แล้วสร้างใหม่อีกครั้ง 
10.10. Clear History เพ่ือลบรายการของไฟล์ที่ใช้บ่อยออกจากรายการ 

12. เมนู Help ประกอบด้วยเมนูย่อย ดังต่อไปนี้
11.1. Contents เพ่ือหัวข้อคู่มือการใช้งานโปรแกรม
11.2. Order Online การเชื่อมต่ออินเทอร์เน็ตเพ่ือสั่งซื้อโปรแกรม
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11.3. Registration การเชื่อมต่ออินเทอร์เน็ตเพ่ือลงทะเบียน 
11.4. More Information การเชื่อมต่ออินเทอร์เน็ตเพ่ือค้นหารายละเอียดเกี่ยวกับโปรแกรม

และผลิตภัณฑ์ที่เกี่ยวข้อง 
11.5. User Forum เพ่ือแสดงความคิดเห็นผ่านอินเทอร์เน็ต 
11.6. About เพ่ือแสดงข้อมูลเกี่ยวกับโปรแกรม 
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2. แถบเครื่องมือ (Tool Bar) เป็นแถบคำสั่งที่ใช้บ่อยๆ เครื่องมือเหล่านี้จะอยู่ในแถบเมนู(Menu
Bar) อยู่แล้ว แต่เพ่ือให้เกิดความสะดวกรวดเร็ว และสามารถเรียกใช้งานได้ทันทีที่ต้องการ ดังรูป 

ปุ่ม
เครื่องมือ 

ชื่อ หน้าที่การทำงานของปุ่มเครื่องมือ 

QuickStart สร้างหนังสือตามรูปแบบที่กำหนดให้ 

Create a New Book สร้างหนังสือเล่มใหม่ 

Open a Book เปิดหนังสือเล่มเก่า 
Open a Folder เปิดโฟลเดอร์ 
Copy File Form คัดลอกแฟ้มข้อมูลจากที่อ่ืน 
Copy Page ทำสำเนาหน้าหนังสือ 
Paste Page วางหน้าหนังสือ 
Insert Multi-Media Object แทรกเสียง ภาพเคลื่อนไหว วีดีโอ 
Insert Annotation แทรกหมายเหตุ (ข้อความ) 
Add or Remove Bookmark เพ่ิมหรือลบที่ค่ันหนังสือ 
Add or Remove Page Marker เพ่ิมหรือลบเครื่องหมายจุดวางหนังสือ 
Flip to Overview เปิดไปยังหน้าแสดงภาพทั้งหมด 
Enable or Disable Background Music เปิดหรือปิดเพลงประกอบ 

Auto Flipping เปิดหน้าหนังสือแบบอัตโนมัติ 
Slide Show แสดงหน้าหนังสือแบบเต็มจอภาพ 

Send as e-mail ส่งงานรูปแบบ e-mail 

Upload to Web ส่งงานขึ้นเว็บไซต์ 
Select Objects เลือกการทำงานของวัตถุ 
How to Burn CD วิธีการสร้างในรูปแบบซีดีรอม 
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3. Flip Book คือ หน้าหนังสือที่พลิกได้ เป็นส่วนที่บันทึกเนื้อหาของ e-Book เนื่องจากมีลักษณะ
คล้ายกับหน้าหนังสือ คือ สามารถพลิกไปยังหน้าต่างๆ ได้ และแสดงภาพเหมือนกับการเปิดพลิก
หนังสือจริง ดังนั้น จึงเรียกส่วนนี้ว่า “Flip Book” หรือส่วนหน้าหนังสือที่เปิดพลิกได้
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การเรียกใช้งานโปรแกรม Flip Album Vista Pro 

คลิกท่ี Start > E-book Systems > Flip Album Vasta Pro หรือดับเบ้ิลคลิกท่ี 
หน้าDesktopโปรแกรมจะแสดงหน้าจอดังรูป 

หน้าจอเริ่มต้นโปรแกรม Flip Album Vista Pro

การเรียกใช้งานจากคำสั่ง Manu Bar 

คลิกเมนูFile > เลือก New Book หรือคลิก  โปรแกรมจะแสดงหน้าจอดังรูป 
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หน้าจอเริ่มต้น New Book

ขั้นตอนการทำ Book Cover (เปลี่ยนพื้นปกหน้า-ปกหลังของหนังสือ) 
จากหน้าจอเริ่มต้น New Book 
เมนู Option > เลือก Set Book Option โปรแกรมจะแสดงหน้าจอดังรูป 

หน้าจอ Set Book Options

วิธีการใช้งานโปรแกรม Book Cover 

เมื่อผู้ใช้งานเข้าสู่หน้าจอ Set Book Options ซึ่งวิธีทำงานของแต่ละส่วนมีดังนี้ 
1. Cover Pages เพ่ือเลือก Front Cover หรือ Back Cover

2. Cover Property คลิก  เพ่ือเลือก Color หรือ Texture 
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กรณีเลือก Color 

2.1. คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 

− คลิก  เพ่ือเลือกสีที่ต้องการ 

− คลิกปุ่ม  เพ่ือยกเลิกการเลือกสี 

− คลิกปุ่ม  เมื่อได้สีที่ต้องการ 

คลิกปุ่ม  เพ่ือยกเลิกสีปก 

คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 
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หน้าจอแสดงผลการเลือก Colors

กรณีเลือก Texture (Front Cover, Back Cover) 

2.2. คลิกปุ่ม  หรือ  โปรแกรมจะแสดงหน้าจอดังรูป 

• ให้ผู้ใช้เลือกไฟล์เอกสารที่ต้องการ

− คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 
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− คลิกปุ่ม  เพ่ือยกเลิกการเปิดรูปภาพ 

− คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 

− คลิกปุ่ม  เพ่ือยกเลิกเลือกรูปภาพ 

− คลิกปุ่ม  โปรแกรมจะแสดงจอดังรูป 
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หน้าจอแสดงผล Front Coverและ Back Cover

ขั้นตอนการทำ Book Background 
จากหน้าจอSet Book Options > Book Background โปรแกรมจะแสดงหน้าจอดังรูป 

หน้าจอ Book Background

วิธีการใช้งานโปรแกรม Book Background 

เมื่อผู้ใช้งานเข้าสู่หน้าจอ Book Background ซึ่งวิธีทำงานของแต่ละส่วนมีดังนี้ 

1. คลิก  Color >  คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 
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− คลิก  เพ่ือเลือกสีที่ต้องการ 

− คลิกปุ่ม  เพ่ือยกเลิกการเลือกสี 

− คลิกปุ่ม  เมื่อได้สีที่ต้องการ 

คลิกปุ่ม  เพ่ือยกเลิกสีปก 

คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 

หน้าจอแสดงผล Book Background

2. คลิก  Texture เพ่ือเลือก  หรือ  โปรแกรมจะแสดงหน้าจอ
ดังรูป
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• ให้ผู้ใช้เลือกไฟล์รูปภาพที่ต้องการ

− คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 

− คลิกปุ่ม  เพ่ือยกเลิกการเปิดรูปภาพ 

− คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 

− คลิกปุ่ม  เพ่ือยกเลิกเลือกรูปภาพ 

− คลิกปุ่ม  โปรแกรมจะแสดงจอดังรูป 
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หน้าจอแสดงผล Book Background 

ขั้นตอนการเพิ่มข้อความบนหน้าปก 
จากหน้าจอแสดงผล Book Background 
คลิกขวาบนหน้าปก > เลือก Annotate โปรแกรมจะแสดงหน้าจอดังรูป 

หน้าจอ Annotate 
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วิธีการใช้งานโปรแกรม Annotate 

1. พิมพ์ตัวอักษรลงในกล่องข้อความ

2. คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 

− คลิก  เพ่ือเลือกสีตัวอักษร 

− คลิกปุ่ม  เพ่ือยกเลิกการเลือกสี 

− คลิกปุ่ม  เมื่อได้สีที่ต้องการ 

3. คลิก  เพ่ือเลือกรูปแบบตัวอักษร, ขนาดตัวอักษร 

4. คลิก  เพ่ือเลือกตัวอักษรตัวหนา, ตัวเอียง, ขีดเส้นใต้ 

5. คลิก  เพ่ือเลือกการจัดวางตัวอักษร คลิกเมาส์พื้นที่ว่าง 
การจัดวางข้อความ 

• ให้ผู้ใช้คลิกเมาส์ที่ตัวอักษร โปรแกรมจะแสดงหน้าจอดังรูป
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− คลิก  เพ่ือเคลื่อนย้ายตัวอักษรซ้าย-ขวา, บน-ล่าง และความกว้างตัวอักษร
หรือ นำเมาส์ไปคลิกท่ีเส้นประกดเมาส์ค้างไว้แล้วลากไปวางยังจุดที่ต้องการ

หน้าจอแสดงผลการจดัวาง และการเพิ่มข้อความหน้าปก

ขั้นตอนการทำ Insert Page (เพิ่มหน้าหนังสือ e-book) 
จากหน้าจอแสดงผลการจัดวาง และการเพ่ิมข้อความหน้าปก 
เมน ูEdit > เลือก Insert Page โปรแกรมจะแสดงหน้าจอดังรูป 

หน้าจอ Insert Page

วิธีการใช้งานโปรแกรม Insert Page 

เมื่อผู้ใช้งานเข้าสู่หน้าจอ Insert Page ซึ่งวิธีทำงานของแต่ละส่วนมีดังนี้ 
1. คลิกLeft Page เพ่ือเพ่ิมหน้ากระดาษด้านซ้าย
2. คลิกRight Page เพ่ือเพ่ิมหน้ากระดาษด้านขวา
3. คลิก Multiple Page เพ่ือเพ่ิมหน้ากระดาษแบบระบุจำนวน โปรแกรมจะแสดงหน้าจอดังรูป
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หน้าจอ Insert Multiple Pages

• ให้ผู้ใช้คลิกเลือกแทรกหน้าหนังสือแบบที่ต้องการ

− Number of pages คลิก  เพ่ือใส่ตัวเลขหน้าหนังสือที่ต้องการเพิ่ม 

− คลิกปุ่ม  เพ่ือยกเลิกการเพ่ิมหน้าหนังสือ 

− คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 

หน้าจอแสดงผล Insert Page
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ขั้นตอนการทำ Page Background 
จากหน้าจอ Set Book Options > Page Background โปรแกรมจะแสดงหน้าจอดังรูป 

หน้าจอ Page Background

วิธีการใช้งานโปรแกรม Page Background 

เมื่อผู้ใช้งานเข้าสู่หน้าจอ Page Background ซึ่งวิธีทำงานของแต่ละส่วนมีดังนี้ 
1. Pages เพ่ือเลือก Left Page, Right Page, Centerfold Page

Page Property

2. คลิก  เพ่ือเลือก Color > คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 

− คลิก  เพ่ือเลือกสีที่ต้องการ 

− คลิกปุ่ม  เพ่ือยกเลิกการเลือกสี 
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คู่มือการใช้งาน  

− คลิกปุ่ม  เมื่อได้สีที่ต้องการ 

− คลิกปุ่ม  เพ่ือยกเลิกสีปก 

− คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 

หน้าจอแสดงผล Page Background

3. คลิก  Texture เพ่ือเลือก  หรือ  โปรแกรมจะแสดง
หน้าจอดังรูป 

• ให้ผู้ใช้เลือกไฟล์รูปภาพที่ต้องการ

− คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 
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คู่มือการใช้งาน  

− คลิกปุ่ม  เพ่ือยกเลิกการเปิดรูปภาพ 

− คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 

− คลิกปุ่ม  เพ่ือยกเลิกเลือกรูปภาพ 

− คลิกปุ่ม  โปรแกรมจะแสดงจอดังรูป 
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คู่มือการใช้งาน  

หน้าจอแสดงผล Page Background

ขั้นตอนการทำ Insert Multi-Media Object (แทรกรูปภาพ) 
จากหน้าจอแสดงผล Page Background 

เมนู Edit > Insert Multi-Media Object หรือคลิก  โปรแกรมจะแสดงหน้าจอดังรูป 

หน้าจอ Insert Multi-Media Objects

วิธีการใช้งานโปรแกรม Insert Multi-Media Object 

เมื่อผู้ใช้งานเข้าสู่หน้าจอ Insert Multi-Media Object ซึ่งวิธีทำงานของแต่ละส่วนมีดังนี้ 
Select Picture or Audio/Video Files 

1. คลิก  เพ่ือเลือกไฟล์รูปภาพที่ต้องการ 

2. คลิกปุ่ม  เพ่ือดูรูปภาพขนาดย่อ 
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คู่มือการใช้งาน  

3. คลิกเมาส์ค้างที่รูปภาพที่ต้องการ แล้วลากมาวางยังหน้าหนังสือที่ต้องการ โปรแกรมจะแสดง
หน้าจอดังรูป

หน้าจอแสดงผล Insert Multi-Media Object 
วิธีการตกแต่งภาพประกอบ 

จากหน้าจอแสดงผล Insert Multi-Media Object 
คลิกขวาที่รูปภาพที่ต้องการ > เลือก Effects โปรแกรมจะแสดงหน้าจอดังรูป 

หน้าจอ Effects

1. การตกแต่งรูปภาพแบบ 3D, Shadow
1.1. คลิกขวาที่รูปภาพ > เลือก Effects

1.2. คลิก  เพ่ือเลือก 3D, Shadow โปรแกรมจะแสดงหน้าจอดังรูป 
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คู่มือการใช้งาน  

หน้าจอแสดงผล 3D, Shadow

การยกเลิกการตกแต่งรูปภาพแบบ 3D, Shadow 

1.3. จากหน้าจอEffects > คลิก  เพ่ือออกจากการตกแต่งรูป 3D, Shadow รูปภาพจะ
กลับสู่รูปภาพเดิม 

2. การตกแต่งรูปภาพแบบ Select Crop Shape
2.1. คลิกขาวที่รูปภาพ > เลือก Effects > Select Crop Shape โปรแกรมจะแสดงหน้าจอดัง

รูป 

หน้าจอ Select Crop Shape 

2.2. ให้ผู้ใช้เลือกรูปร่างครอบรูปที่ต้องการ 

− คลิกปุ่ม  เพ่ือยกเลิกรูปร่างครอบรูป 

− คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 
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คู่มือการใช้งาน  

หน้าจอแสดงผล Select Crop Shape

การยกเลิกการตกแต่งรูปภาพ Select Crop Shape 
2.3. จากหน้าจอ Effects > เลือก Remove Crop Effect รูปภาพจะกลับสู่รูปภาพเดิม 

3. การตกแต่งรูปภาพแบบ Add/Edit Frame
3.1. คลิกขาวที่รูปภาพ >  เลือก Effects > Add/Edit Frame โปรแกรมจะแสดงหน้าจอดังรูป

หน้าจอ Add Frame

3.2. Please select a Frame Type เพ่ือเลือกประเภทเฟรมจากโปรแกรม 
Frame Options 

3.3. Frame Width คลิกปุ่ม  เพ่ือเลือกความกว้างของเฟรมมากหรือน้อย 

3.4. Frame Corner คลิก  เพ่ือเลือก Square หรือRound 

3.5. Corner Radius คลิกปุ่ม  เพ่ือเลือกตัวเลขมากหรือน้อย 
3.6. Color Selection เพ่ือเลือก Frame Color หรือ Shadow Color โปรแกรมจะแสดง

หน้าจอดังรูป 
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คู่มือการใช้งาน  

− คลิก  เพ่ือเลือกสีกรอบรูปภาพที่ต้องการ 

− คลิกปุ่ม  เพ่ือยกเลิกสีกรอบรูปภาพ 

− คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 

หน้าจอแสดงผล Add/Edit Frame

การยกเลิกการตกแต่งรูปภาพ Add/Edit Frame 
3.7. จากหน้าจอ Effects > เลือก Add/Edit Frame รูปภาพจะกลับสู่รูปภาพเดิม 
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คู่มือการใช้งาน  

หน้าจอแสดงผลการตกแต่งและการจดัวางรปูภาพประกอบ

วิธีการตกแต่งข้อความด้วยโปรแกรม Microsoft Word 

นอกจากการพิมพ์ข้อความจากหน้าหนังสือโดยตรงแล้ว ก็สามารถคัดลอกข้อความจากโปรแกรม
อ่ืนๆ ตัวอย่างเช่นโปรแกรม  Word มาท่ีหน้าหนังสือได้เหมือนกัน จากหน้าจอแสดงผลการตกแต่งและ
การจัดวางรูปภาพประกอบ 

หน้าจอการตกแต่งข้อความ
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คู่มือการใช้งาน  

หมายเหตุ ขั้นตอนการตกแต่งข้อความให้ไปศึกษาจากหัวข้อขั้นตอนการเพ่ิมข้อความบนหน้าปก และ 
วิธีการใช้งานโปรแกรม Annotate ซึ่งหลักการทำงานเดียวกัน ส่วนขั้นตอนนี้จะแนะนำวิธีการนำข้อมูล
จากไฟล์ Microsoft Word ที่ได้ทำการจัดเตรียมไว้แล้ว มาทำการจัดวางและตกแต่งข้อความ 

1. เปิดไฟล์ Microsoft Word ที่ได้ทำการจัดเก็บข้อมูล  โปรแกรมจะแสดงหน้าจอดังรูป

หน้าจอแสดงเอกสาร MS Word 

2. คลิกขวา > เลือก Copy หรือกด Ctrl+C
3. คลิกขวา > เลือก Paste หรือ Ctrl+V หน้าหนังสือที่ต้องการวาง ทำการจัดแต่งและจัดวางให้

เรียบร้อย โปรแกรมจะแสดงหน้าจอดังรูป
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คู่มือการใช้งาน  

หน้าจอแสดงผลการตกแต่งข้อความ Microsoft Word

ขั้นตอนการแก้ไขสารบัญ 
จากหน้าจอแสดงผลการตกแต่งข้อความ Microsoft Word 
เมน ูEdit > Customize Contents โปรแกรมจะแสดงหน้าจอดังรูป 

หน้าจอ Style

วิธีการใช้งานโปรแกรม Customize Contents 

เมื่อผู้ใช้งานเข้าสู่หน้าจอ Style ซึ่งวิธีทำงานของแต่ละส่วนมีดังนี้ 
1. คลิก Title
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คู่มือการใช้งาน  

2. คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 

หน้าจอ Modify Style

3. Text เพ่ือพิมพ์ตัวอักษร

4. คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 

− คลิก  เพ่ือเลือกสีตัวอักษรที่ต้องการ 

− คลิกปุ่ม  เพ่ือยกเลิก 

− คลิกปุ่ม  เพ่ือยืนยัน โปรแกรมจะกลับสู่หน้าจอก่อนหน้า 

5. คลิก  เพ่ือเลือกรูปแบบ และขนาดตัวอักษรที่ต้องการ 

6. คลิก  เพ่ือเลือกตัวอักษรตัวหนา, ตัวเอียง, ขีดเส้นใต้ 
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คู่มือการใช้งาน  

− คลิกปุ่ม  เพ่ือยกเลิก 

− คลิกปุ่ม  โปรแกรมจะกลับสู่หน้าจอหน้าจอ Style 

คลิกปุ่ม  เพ่ือปิดกล่องข้อความ 

คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 

หน้าจอแสดงผลการแก้ไขสารบญั

ขั้นตอนการเปลี่ยนเนื้อหาสารบัญ 
จากหน้าหน้าจอ Style 

วิธีการใช้งานโปรแกรม  

เมื่อผู้ใช้งานเข้าสู่หน้าจอ Style ซึ่งวิธีทำงานของแต่ละส่วนมีดังนี้ 
1. คลิก TOC 1

2. คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 
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คู่มือการใช้งาน  

หน้าจอ Modify Style

3. Indent คลิกปุ่ม  เพ่ือเปลี่ยน TOC

4. คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 

− คลิก  เพ่ือเลือกสีตัวอักษรที่ต้องการ 

− คลิกปุ่ม  เพ่ือยกเลิก 

− คลิกปุ่ม  โปรแกรมจะกลับสู่หน้าจอ Modify Style 

5. คลิก  เพ่ือเลือกรูปแบบ และขนาดตัวอักษรที่ต้องการ 

6. คลิก  เพ่ือเลือกตัวอักษรตัวหนา, ตัวเอียง, ขีดเส้นใต้ โปรแกรมจะกลับสู่
หน้าจอ Style
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คู่มือการใช้งาน  

− คลิกปุ่ม  เพ่ือปิดกล่องข้อความ 

− คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 

หน้าจอแสดงผลการเปลี่ยนเนื้อหาสารบัญ

• ให้ผู้ใช้ทำการเปลี่ยนเนื้อหาสารบัญ ดังนี้
7. เมื่อนำเมาส์ไปวางยังบรรทัดที่ต้องการจะเปลี่ยนเนื้อหา โปรแกรมจะแสดงกรอบสี่เหลี่ยมดัง

รูป

8. คลิกขวา > เลือก Rename โปรแกรมจะแสดงกรอบสี่เหลี่ยม ดังรูป

9. เพ่ือพิมพ์ตัวอักษรเนื้อหาสารบัญที่ต้องการ โปรแกรมจะแสดงหน้าจอดังรูป

51



 การสร้าง e-book โดยใช้โปรแกรม Flip Album 

คู่มือการใช้งาน  

หน้าจอแสดงผลการเปลี่ยนชื่อสารบญั

ขั้นตอนการทำ Book Binder (สันปกหนังสือ) 
จากหน้าจอแสดงผลการเปลี่ยนชื่อสารบัญ 
เมนู Options > Book Binder > เลือก Three Rings จากตารางดังรูป 

หน้าจอตาราง Three Rings
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คู่มือการใช้งาน  

วิธีการใช้งานโปรแกรม Book Binder 

เมื่อผู้ใช้งานเข้าสู่หน้าจอ Three Rings ซึ่งวิธีทำงานมีดังนี้ 

7. คลิก  เพ่ือเลือกสันหนังสือที่ต้องการจากตาราง โปรแกรมจะแสดงหน้าจอดังรูป

หน้าจอแสดงผล Book Binder

ขั้นตอนการทำ Bookmarks 
จากหน้าจอแสดงผล Book Binder 
เมน ูBookmarks เพ่ือเลือก Add หรือ Define Bookmark Style 

− คลิก Add เพ่ือเลือก Left Page หริอ Right Page หรือคลิกปุ่ม  โปรแกรมจะ
แสดงหน้าจอดังรูป

หน้าจอ Bookmark Content
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คู่มือการใช้งาน  

หมายเหตุ  วิธีการใช้งานมีให้ศึกษาในขั้นตอนโปแกรม Define Bookmark Style 

− คลิก Define Bookmark Style โปรแกรมจะแสดงหน้าจอดังรูป

หน้าจอ Define Bookmark Style

วิธีการใช้งานโปรแกรม Define Bookmark Style 

เมื่อผู้ใช้งานเข้าสู่หน้าจอ Define Bookmark Style ซึ่งวิธีทำงานของแต่ละส่วนมีดังนี้ 

8. Shape คลิก  เพ่ือเลือก Rounded หรือ Triangle  
9. Effect คลิก  เพ่ือเลือก 3D Effect, Gradient Effect

10. คลิกปุ่ม  เพ่ือเลือกตัวเลข Slope, Gap

− คลิกปุ่ม  เพ่ือออกจากหน้าจอ Define Bookmark Style 

− คลิกปุ่ม  เพ่ือยืนยันการเปลี่ยนรูปแบบฺ Bookmark 

คลิก  โปรแกรมจะแสดงหน้าจอดังรูป 

หน้าจอ Bookmark Content 

1. Bookmark Text เพ่ือพิมพ์ชื่อที่ค่ันข้อความ
2. คลิก Color โปรแกรมจะแสดงหน้าจอดังรูป
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คู่มือการใช้งาน  

− คลิก  เพ่ือเลือกสีBookmarkที่ต้องการ 

− คลิกปุ่ม  เพ่ือยกเลิกสี Bookmark 

− คลิกปุ่ม  เพ่ือยืนยันสี Bookmark 

คลิกปุ่ม  เพ่ือยกเลิกการทำ Bookmark 

คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 

หน้าจอแสดงผล Bookmark
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คู่มือการใช้งาน  

ขั้นตอนการทำ Marker 
1. คลิกเมนู Markers > เลือก Define Marker Style โปรแกรมจะแสดงหน้าจอดังรูป

หน้าจอ Define Marker Style 

• ให้ผู้ใช้คลิกเลือกรูปสัญญาลักษณ์ตัวคั่นหนังสือ

− คลิกปุ่ม  เพ่ือยกเลิกรูปสัญญาลักษณ์ตัวคั่นหนังสือ 

− คลิกปุ่ม  เพ่ือยืนยันรูปสัญญาลักษณ์ตัวคั่นหนังสือ

2. คลิกปุม  โปรแกรมจะแสดงหน้าจอดังรูป 

หน้าจอแสดงผล Markers 

การลบ Bookmarks และ Markers 

คลิกเมนู Bookmarks หรือ Markers  
คลิก Remove เพ่ือเลือก Left Page หรือ Right Page สัญญาลักษณ์ที่ค่ันก็จะหายไป 
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ขั้นตอนการลบหน้าหนังสือ 
จากหน้าจอแสดงผลการเพ่ิมหน้าหนังสือ 

หน้าจอแสดงผลการเพิม่หน้าหนังสือ

− คลิกขวา > เลือก Delete Page โปรแกรมจะแสดงหน้าจอดังรูป

หน้าจอแสดงผลการลบหน้าหนังสือ
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ขั้นตอนการทำ Audio 
มีวิธีการเข้าใช้งานระบบ 2 วิธีดังนี้ 
วิธีที่ 1 
เมนู Option > Set Book Option > Audio โปรแกรมจะแสดงหน้าจอดังรูป 

หน้าจอ Audio

วิธีที่ 2 

Tool Bar > คลิกปุ่ม  โปรแกรมจะแสดงกล่องข้อความดังรูป 

− คลิกปุ่ม  เพ่ือยกเลิกข้อมูล 

− คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอ Audio 
วิธีการใช้งานAudio 

มีวิธีการบันทึกไฟล์เพลงมี 2  แบบ 

แบบท่ี 1 แบบเพลงเดียวทั้งเล่ม มีวิธีดังนี้ 
เมื่อผู้ใช้งานเข้าสู่หน้าจอ Audio ซึ่งวิธีทำงานของแต่ละส่วนมีดังนี้ 

1. คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 
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• ให้ผู้ใช้เลือกไฟล์เพลงที่ต้องการ

− คลิกปุ่ม  เพ่ือยกเลิกไฟล์เพลง 

− คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 

หน้าจอแสดงผลการเลือกAudio

2. คลิก  เพ่ือเลือก Enable Audio

คลิกปุ่ม  เพ่ือยกเลิกไฟล์เอกสาร 

คลิกปุ่ม  ก็จะปรากฏเสียงเพลงที่ต้องการ 
3. Background Music List จะปรากฏชื่อไฟล์เพลงที่ผู้ใช้งานได้เลือกไว้

ขั้นตอนการฟังเพลงพร้อมเปิดเอกสารแบบเต็มหน้าจอ 
เมนู Tools > เลือก Slide Show โปรแกรมจะแสดงหน้าจอดังรูป 
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หน้าจอแสดงผล Slide Show 

การออกจากหน้าจอ Slide Show 
จากหน้าจอ Slide Show คลิกขวา โปรแกรมจะแสดงกล่องข้อความดังรูป 

คลิก Exit เพ่ือออกจากหน้าจอ Slide Show โปรแกรมก็จะกลับสู่หน้าจอก่อนหน้า 

การลบเสียงเพลง 
จากหน้าจอแสดงผลการเลือก Audio 

Background Music List เพ่ือเลือกไฟล์เพลงที่ต้องการลบ 

− คลิกปุ่ม  เพ่ือลบไฟล์เพลง 

− คลิกปุ่ม  เพ่ือยกเลิกการลบไฟล์เพลง 

− คลิกปุ่ม  เพ่ือยืนยันการลบไฟล์เพลง 
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แบบท่ี 2 แบบหนังสือแต่ละหน้าเสียงเพลงไม่เหมือนกัน มีวิธีดังนี้ 
1. คลิกขวา > เลือก Page Properties โปรแกรมจะแสดงหน้าจอดังรูป

หน้าจอ Set Page Properties

2. Set Page Audio คลิก  เลือก File > คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอ
ดังรูป

• ให้ผู้ใช้เลือกไฟล์เพลงที่ต้องการ

− คลิกปุ่ม  เพ่ือยกเลิกไฟล์เพลง 

− คลิกปุ่ม  เพ่ือยืนยัน 

3. Set Page Background คลิก  เลือก Default 

− คลิกปุ่ม  เพ่ือยกเลิกไฟล์เพลง 

− คลิกปุ่ม  เพ่ือเลือกไฟล์เพลงที่ต้องการ 
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การหยุดเสียงเพลง 

จากเมนู Options > คลิก  Enable Background Music หรือคลิกปุ่ม 

การลบเสียงเพลง 
จากหน้าจอ Set Page Properties 

Set Page Audio คลิก  เลือก Default 

− คลิกปุ่ม  เพ่ือยกเลิก 

− คลิกปุ่ม  เพ่ือยืนยันการลบไฟล์เพลง 

ขั้นตอนการบันทึกไฟล์งาน 
1. คลิกเมนู File > เลือก Save หรือ Save As โปรแกรมจะแสดงหน้าจอดังรูป

หน้าจอ Save As 

2. Save in คลิก  เพ่ือเลือกสถานที่ที่ต้องการจัดเก็บไฟล์งาน 
3. File name พิมพ์ชื่อไฟล์เอกสารที่ต้องการบันทึก

− คลิกปุ่ม  เพ่ือยกเลิกการบันทึก 

− คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป
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คู่มือการใช้งาน  

หน้าจอแสดงผลการบันทึกไฟล์งาน 

ขั้นตอนการเปิดไฟล์งานเดิม 

1. คลิกเมนู File > เลือก Open Book หรือคลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 

หน้าจอ Open A Book

2. Please enter path or web address below คลิก  เพ่ือเลือกท่ีอยู่ไฟล์เอกสาร 

หรือคลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 
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คู่มือการใช้งาน  

หน้าจอ Open

− Look in คลิก  เพ่ือเลือกอยู่ไฟล์เอกสาร 

− File name คลิก  เพ่ือเลือกชื่อไฟล์เอกสาร 

คลิกปุ่ม  เพ่ือยกเลิกเปิดไฟล์เอกสาร 

คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 

หน้าจอแสดงผลการเปิดไฟล์เอกสารเดิม 

ขั้นตอนการบันทึกข้อมูล 
การบันทึกข้อมูลสามารถบันทึกข้อมูลได้ 2 แบบประกอบด้วย 

1. คลิกเมนู File > Save หรือ Ctrl+S เพ่ือบันทึกข้อมูลในชื่อไฟล์เดิม
2. คลิกเมนู File > Save As… เพือ่บันทึกข้อมูลในช่ือไฟล์ใหม่
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วิธีการใช้งานโปรแกรม QuickStart 

เมื่อผู้ใช้งานเข้าสู่หน้าจอโปรแกรม Flip Album Vista Pro ซึ่งมีวิธีทำงานดังนี้ 

❖ จากหน้าจอ Flip Album Vista Pro คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 

หน้าจอ QuickStart 

การแสดงรายละเอียดข้อมูล QuickStart 

1. Open Folder
− Three Easy Steps to Create an Album เพ่ือเลือก Choose a Folder of Images

หรือ and create a complete album โปรแกรมจะแสดงหน้าจอดังรูป

หน้าจอ Choose your folder of images

• ให้ผู้ใช้คลิกเลือกไฟล์เอกสาร, ไฟล์รูปภาพ ที่ต้องการบันทึกข้อมูล กรณีท่ีสร้างโฟล์
เดอร์งานไว้แล้ว

− คลิกปุ่ม  เพ่ือไปหน้ายังขั้นตอนต่อไป 
2. Page Layout โปรแกรมจะแสดงหน้าจอดังรูป

− Click to choose the layout of your album เพ่ือเลือก Single Image per page
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หรือ Centerfold page 

หน้าจอ Click to choose the layout of your album

• ให้ผู้ใช้คลิกเพ่ือเลือกรูปแบบอัลบั้มที่ต้องการ

− คลิกปุ่ม  เพ่ือไปหน้ายังหน้าจอถัดไป 
3. Themes โปรแกรมจะแสดงหน้าจอดังรูป

หน้าจอ Choose the theme for your album

• ให้ผู้ใช้คลิกเลือกธีมสำหรับอัลบั้มที่ต้องการ (ซึ่งสามารถเปลี่ยนแปลงในภายหลังได้)

− คลิกปุ่ม   เพ่ือกลับไปยังหน้าจอก่อนหน้า 

− คลิกปุ่ม  เพ่ือยกเลิกการเลือกธีมเอกสาร 

− คลิกปุ่ม  โปรแกรมจะแสดงหน้าจอดังรูป 
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คู่มือการใช้งาน  

หน้าจอแสดงผล QuickStart 

กรณีต้องการสร้างงานใหม่ 

จากหน้าจอ QuickStart ให้ผู้ใช้งานคลิกปุ่ม  โปรแกรมจะกลับสู่หน้าจอเริ่มต้น 

โปรแกรม Flip Album Vista Pro 

การออกจากโปรแกรม 
มี 4 แนวทาง ประกอบด้วย 

1. คลิกปุ่ม  เพ่ือปิดโปรแกรม Flip Album Vista Pro 
2. คลิกเมนู File > เลือก Exit เพ่ือออกจากโปรแกรม Flip Album Vista Pro

3. ดับเบ้ิลคลิกท่ี 

4. คลิกท่ีไอคอล > เลือก Close
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